Chapter 1

Becoming Familiar with SolidWorks

- Start SolidWorks
- Navigate the SolidWorks Interface
- Use the CommandManager
- Use and Customize the Menus
- Use Toolbars
- Use the Keyboard
- Use the Mouse
SolidWorks 2010 is one of the most popular 3D mechanical computer-aided design (CAD) packages on the market today. Since its introduction in 1995, SolidWorks has become a favorite design tool for many of today's engineers, mechanical designers, and industrial designers. In part because of its easy-to-learn graphical user interface and powerful set of tools, SolidWorks is used by many top companies worldwide to design, engineer, and document their products in a variety of fields.

At the core of SolidWorks is the ability to create parametric 3D solid geometry that is then used to create drawings, manufacturing instructions, instruction manuals, animations, full-color renderings, and other types of documentation. Regardless of the complexity of the item being created, the creation process is easy and follows the same basic steps. First a sketch is created that is turned into a base feature. The base feature is then further refined by adding features that add or remove material from the base feature. Individual part models can then be used to build assemblies that represent the final design. After creating the 3D part or assembly models, drawings are made to document the design and manufacturing process.

Learning a new CAD package can be a daunting task. In addition to the new terminology, first-time users may feel a bit overwhelmed with a new user interface, toolbars, and commands. In this chapter, you will spend some time launching SolidWorks for the first time, becoming familiar with the SolidWorks interface, and working with the CommandManager.

**Start SolidWorks**

Before installing and running SolidWorks for the first time, ensure that you meet the recommended minimum system requirements. SolidWorks currently supports the following operating systems:

- Windows 7 (64-bit) Professional, Ultimate or Enterprise Edition.
- Windows Vista (64-bit) Ultimate, Business, or Enterprise edition, SP0 or newer
- Windows Vista (32-bit) Ultimate, Business, or Enterprise edition, SP0 or newer
- Windows XP Professional (32-bit), SP2 or newer
- Windows XP Professional (64-bit)
And here are the random-access memory (RAM) requirements:

**Minimum**  1GB RAM when parts contain fewer than 200 features and assemblies contain fewer than 1,000 components

**Recommended**  2GB RAM or more when parts contain more than 200 features and assemblies contain more than 1,000 components

Once you have verified that your computer is able to support SolidWorks and it is installed onto your system, you can launch it by selecting Start ➢ Programs ➢ SolidWorks 2010 ➢ SolidWorks 2010 SPX.X ➢ SolidWorks 2010.

**NOTE** All images in this book are from SolidWorks running on Windows 7. You might notice a slight difference if you are using another version of Windows such as Windows XP.

**SolidWorks License Agreement**

The first time you launch SolidWorks, you will be presented with the SolidWorks License Agreement. You must accept the license agreement in order to use SolidWorks. After reading the license, click Accept to continue. If for some reason you do not accept the terms of the license agreement, clicking Do Not Accept will exit SolidWorks.

**Help and Workflow Customization**

After accepting the SolidWorks License Agreement, you will then be presented with the Welcome To SolidWorks window. This screen allows you to customize the appearance of dynamic help as well as the workflow. You will see this only the first time you launch SolidWorks on your computer, but you can make changes to the options anytime you want in the SolidWorks Options window.

Three options are available in the Help Customization section of the screen. Each option will provide the user with a different level of dynamic help, so consider your needs when making your selection.

**I Am A New User. Show Quick Tips To Help Me Get Started.**  This option will provide you with pop-up messages that appear while working in different modes of SolidWorks.

**I Am New To This Version Of SolidWorks. Show Me Interactive What’s New Help.**  Experienced SolidWorks users will find this option helpful when they are working
in a new version of SolidWorks. When this option is selected, a question-mark icon will be displayed on new menu items and new and changed PropertyManagers and will link to the corresponding sections of the What’s New manual. The topics in the What’s New manual will then provide more information about the new or updated functionality since the previous release.

Do Not Show Me Any Dynamic Help. For more experienced users, this option will not provide you with any pop-ups or links to the What’s New manual while working in SolidWorks.

**Note** As you become more familiar with working in SolidWorks, you may decide to disable the Quick Tips. You can disable them by selecting Help ➢ Quick Tips or by clicking the question-mark icon in the status bar. After becoming familiar with the updates made to the new release of SolidWorks, you can disable the display of the link by selecting Help ➢ Interactive What’s New.

The Workflow Customization section of the Welcome To SolidWorks window allows you to hide and display tools, links, and menus items based on your usage of SolidWorks. You can select one, two, all, or none of the following categories:

- Machine Design
- Mold Design
- Consumer Product Design

When you select an option in the Workflow Customization section of the window, the following changes will occur in your part document environment:

**Machine Design** The Machine Design Overview, Machine Design Tutorials, and SolidWorks SimulationXpress links will be displayed on the SolidWorks Resources tab of the task pane. Sheet Metal and Weldments tabs will be added to the CommandManager. The Molds menu item will be hidden in the Insert menu. Draft Analysis, Undercut Detection, and Deviation Analysis will also be hidden in the Tools menu.

**Mold Design** The Mold Design Overview, Mold Design Tutorials, and Import File links will be displayed on the SolidWorks Resource tab of the task pane. Surfaces and Molds tabs will be added to the CommandManager. The Weldments menu item will be hidden in the Insert menu.

**Consumer Product Design** A Consumer Product Tutorials link will be displayed on the SolidWorks Resources tab of the task pane. The Surfaces tab will be added to the CommandManager. The Weldments menu item will be hidden in the Insert menu. The Undercut Detection menu item will be hidden in the Tools menu.
NOTE You can adjust your workflow customization at any time while in a part file by selecting Tools ➢ Customize and select the Options tab. In the Work flow Customization section, select or deselect the appropriate options.

For the sake of the project being demonstrated in this book, in the Welcome To SolidWorks window select the following:

1. In the Help Customization section, select Do Not Show Me Any Dynamic Help.


3. Click OK.

Navigate the SolidWorks Interface

Before using SolidWorks, you should become familiar with the layout of the user interface. Each of the three document types in SolidWorks (parts, assemblies, and drawings) has the same basic interface with a few minor differences. To start, we will examine the common elements of the three document types. Figure 1.1 shows the SolidWorks interface when you have a part model open.

Graphics Area

The place where all the action takes place in SolidWorks is the graphics area. Here you will be modeling your parts, putting together your assemblies, and creating your drawings. You will be exploring this area in a lot more detail in Chapter 2, “Learning the Basics,” when we cover the three document types in more detail.
Heads-up View Toolbar

At the top of the graphics area is the **Heads-up View toolbar**. This transparent toolbar is always available at the top of your graphics area, giving you quick and easy access to the tools necessary to manipulate your views. Icons that display a small downward-pointing arrow provide you with more tools in a flyout, as shown in Figure 1.2.

As you become more comfortable in SolidWorks, you may discover that the tools available on the Heads-up View toolbar may not be what you use most often. The
view tools shown by default are not the only tools that are available for the toolbar. To customize the Heads-up View toolbar, do the following:

1. Right-click any of the buttons shown in the Heads-up View toolbar, and select Customize from near the bottom of the menu.

2. Select the Commands tab at the top of the Customize window.

3. In the Categories section of the window, locate your desired tool set. For this example, select Standard Views in the Categories section. The tools included in the selected category will be displayed in the Buttons section, as shown in Figure 1.3.

4. Drag the desired button in the Customize window to the top of the Heads-up View toolbar. When the mouse pointer changes to include a green plus, drop the button there.

**Figure 1.3 Commands tab in the Customize window**

**Note** The Heads-up View toolbar can be hidden in SolidWorks 2010. To hide the toolbar, right-click any button in the toolbar, and deselect View (Heads-Up) in the menu.
Status Bar

Along the bottom of the SolidWorks interface is the status bar. As the name suggests, the status bar will give you information about the actions you are performing in SolidWorks. The status bar can be turned off in the View menu, but we strongly recommend leaving it on since it can prove to be extremely useful while you work. Here are some examples of the information that you can find in the status bar:

- As you hover over a tool, the status bar will often provide you with a better description than what the tooltips will normally provide (see Figure 1.4). When you become familiar with the icons for the various tools in SolidWorks, you will require this information less often.

![Figure 1.4 Additional tool information displayed in the status bar](image)

- Selecting on an edge, point, or any combination of these will display basic measurements for quick reference, as shown in Figure 1.5. This should not replace the Measure tool, but it can be extremely helpful when you are just looking for a quick idea of the distance between two edges.

![Figure 1.5 Quick way to show measurements in the status bar](image)

- As you work in a sketch, the coordinates for your mouse pointer location will be displayed as well as the status of your sketch. The sketch status will be displayed as Fully Defined, Over Defined, Under Defined,
No Solution Found, or Invalid Solution Found. We will be covering what each of these means later when we start working sketches.

Task Pane

On the right side of the graphics area is the task pane. The task pane is a set of windows that provides a number of resources in one location. Normally, the task pane is hidden, and the tab icons are the only thing visible in the graphics area. This is probably the best option since real estate in your graphics area is very valuable. However, if you prefer to have the task pane always open, you can do the following:

1. Click any of the task pane tab icons.

2. On the top right of the task pane, click the pushpin icon to “pin open” the task pane (see Figure 1.6).

3. The graphics will adjust to make room for the task pane, and it will remain open even as you click elsewhere in SolidWorks.

4. To set the task pane to autohide once again, click the pushpin icon.

**Figure 1.6** Pinning the task pane open and hiding it again
In addition to being docked on the right side of the graphics area, the task pane can also be floated. This is especially useful if you are working with dual monitors. We often find it is helpful to float the task pane onto a second monitor and pin it open. To float your task pane, do the following:

1. Click any task pane tab icon to open the task pane.
2. Drag the title bar away from the right side of the graphics area.
3. Release the left mouse button.
4. To redock the task pane, click and hold the title bar of the task pane with the left mouse button, and drag the task pane back to the right side of the screen. The task pane will snap back into place when the correct position is reached.

Now we’ll take you through all the parts of the task pane.

**SolidWorks Resources**

The *SolidWorks Resources tab* of the task pane gives you quick access to common tasks such as creating a new document, opening an existing document, and using online tutorials. Additionally, users can get to the SolidWorks customer portal, user forums, workflow-specific tutorials, manufacturers’ websites, and even view the Tip of the Day. Often, the SolidWorks Resources tab is overlooked by users, which is a shame because it gives you access to a wealth of information in one place. Figure 1.7 shows the entire SolidWorks Resources tab.

**Design Library**

The *Design Library tab* usually points to a location on the local PC that is used to store common reusable items such as parts, assemblies, and sketches. Documents that are located in the Design Library can easily be added to the active document by dragging and dropping. Figure 1.8 shows the Design Library tab of the task pane with the menu options collapsed.
Navigate the SolidWorks Interface

**Figure 1.7** SolidWorks Resources tab of task pane

**Figure 1.8** Design Library tab of task pane

**File Explorer**

The *File Explorer tab* gives you access to your files on your local PC and network just like Windows Explorer, as shown in Figure 1.9.
You can adjust the folders shown in the File Explorer on the System Options tab, as described in the following steps:

1. Click the Options button in the menu bar.


3. Select the folders you want to be displayed in the File Explorer tab.

4. Deselect the folders that you want to be hidden in the File Explorer tab.

5. Click OK to accept your changes.

**Search**

Searches that are performed in the Search Assistant in the menu bar are displayed on the Search tab. Searches performed in SolidWorks are faster than most search engines because the searching is done on indexed files, and SolidWorks does not have to go digging through your PC to find a file. When SolidWorks was installed, the Windows Desktop Search was also installed to create the index of your files. This index should have been created after installation; if not, it will be created the first time you do a search.

From within SolidWorks, you can quickly search for files by a full-text search, advanced search, keywords, or retrieval of all types of documents. One of the most common searches you will perform will probably be a keyword search. To perform a keyword search, do the following:

1. Click in the SolidWorks search tool on the menu bar.
2. Type the text or keywords for your search criteria.

3. Press Enter.

All the files that match your search criteria will be displayed in the Search tab of the task pane, as demonstrated in Figure 1.10. If the search returns more files than what can be displayed on one screen of the Search tab, you can navigate through the results.

4. To move to the next screen, click the blue right-pointing arrow, or click Next at the bottom of the Search tab (see Figure 1.11).

5. To return to a previous screen, click the blue left-pointing arrow.

6. To jump to a specific page, select the page number at the bottom of the tab.

View Palette

The View Palette tab contains images of standard views, section views, annotation views, and flat patterns that can be dragged into a drawing, as shown in
Figure 1.12. The View Palette tab displays available drawing views when you create a drawing from a part or assembly, browse to a document from the View Palette tab, or select a document in the list of open documents from the View Palette tab.

**FIGURE 1.12 View Palette tab of task pane**

**Appearances/Scenes**

The *Appearances/Scenes tab* contains appearances that you can add to your models without actually adding the physical properties of the selected material to your part, as shown in Figure 1.13. By dragging from the Appearances tab, you can drop the material likeness onto your models to give them the look of metal, plastic, glass, and other material types. In Scenes, you can also change the environment in your models with different backgrounds and lighting schemes. We will be covering appearances and scenes in later chapters.

**Custom Properties**

The *Custom Properties tab*, shown in Figure 1.14, provides you with a quick way to input custom properties for the active document. Before the Custom Properties tab can be used to update the properties for your documents, the property page must be built, usually by an administrator. We will be covering custom properties for parts, assemblies, and drawings in later chapters.
Menu Bar

At the top of the screen is the ribbon-style menu bar, shown in Figure 1.15. The menu bar provides quick access to the most common actions including creating, opening, saving, and printing documents.

If you are familiar with previous versions of SolidWorks, you may notice the lack of pull-down menus. Not to worry, they are still there for the times you need them.
If you hover over the SolidWorks logo on the left side of the menu bar, the menu items will fly out. Nearly all SolidWorks commands are available in these pull-down menus, but some menus and menu items will only be available depending on the active document type.

**CommandManager**

The CommandManager by default is located below the menu bar and is a context-sensitive toolbar, as shown in Figure 1.16. Context-sensitive means that the toolbar will update based on the toolbar you want to utilize and will be also updated based on the active document type. We will be discussing the CommandManager in more detail in the upcoming “Use the CommandManager” section.

**FeatureManager Design Tree**

To the left of the graphics area you will find the FeatureManager design tree, shown in Figure 1.17. The FeatureManager acts as a time machine, of sorts, by providing you with an outline view of the history of the construction of a part or assembly. You can use it to view the various sheets and views in a drawing. We will be spending some time on the FeatureManager design tree in later chapters.

**Toolbars**

Just like in all Windows-based programs, toolbars contain most of the tools available in SolidWorks. Each toolbar is named for the functions of the tools that are contained such as surfacing, mates, sketch tools, and so on. Figure 1.18 shows an example toolbar. Toolbars can be floated anywhere within the SolidWorks border or docked to the sides. Even though there are many toolbars at your disposal, we
will be showing you a technique that virtually eliminates the need for toolbars in SolidWorks by using the CommandManager, shortcut bars, mouse gestures, menus, and in-context toolbars.

![FeatureManager design tree](image)

**FIGURE 1.17** FeatureManager design tree

![SolidWorks toolbar](image)

**FIGURE 1.18** A SolidWorks toolbar

### Use the CommandManager

The CommandManager was introduced in SolidWorks 2004 to mixed reviews. Since then, the CommandManager has evolved into the powerful tool you see today. The CommandManager plays a central role in the creation of SolidWorks documents by dynamically updating the tools based on the toolbar you are accessing. Depending on the document type you are editing, the tabs shown below
the CommandManager will display the toolbars that are related. For example, when you are working in a part document, the CommandManager will display the Features, Sketch, Evaluate, and DimXpert tabs by default. However, when you are working in a drawing, the CommandManager will display only the View Layout, Annotation, Sketch, and Evaluate tabs.

Using the CommandManager couldn’t be any easier. Instead of hunting down a particular toolbar, simply click the tab that corresponds to the set of tools you require, and click the desired tool. In some cases, the CommandManager will attempt to eliminate the number of clicks required by activating the tab that corresponds with the environment you are working in.

**Access the CommandManager**

If you find yourself sitting at an installation of SolidWorks that has the CommandManager turned off, don’t try to fumble your way through; turn it back on. You can turn the CommandManager on using one of the following two techniques:

- Right-click the menu bar, and select CommandManager from the very top of the menu, as shown in Figure 1.19.

![Figure 1.19 Accessing CommandManager from the menu bar](image)

- Hover or click the SolidWorks logo on the left side of the menu bar to make the Tools menu visible; then select Tools ➢ Customize ➢ Enable CommandManager.

**Float and Dock the CommandManager**

Prior to SolidWorks 2009, the CommandManager wasn’t able to be moved from below the menu bar but now it can be floated or even docked on a different side of the SolidWorks window. Here’s how:

1. With the mouse, select the CommandManager with the left mouse button where no tool is present and drag the CommandManager from its original location down to the graphics area (See Figure 1.20).
T I P  Double-clicking the CommandManager when it is docked will make it float. Double-clicking the CommandManager when it is floating will return it to its last docked position.

2. If you release the mouse button while the CommandManager is in the middle of the SolidWorks window, it will “float” where placed. This can be extremely useful if you prefer to have the CommandManager close to your working area.

3. If you click the Auto Collapse button on the upper-left corner of the CommandManager, the buttons will disappear when it loses focus. A small box with the title will be the only thing showing.

4. To show the buttons available in the CommandManager once again, simply move the mouse pointer over the title of the CommandManager once again.
If you prefer, you can also dock the CommandManager on one side of the SolidWorks window by following these steps:

1. Select the title bar of the CommandManager, if floating, or select the docked CommandManager.

2. Drag the CommandManager over to one of the three available docking icons, as shown in Figure 1.21.

3. With the mouse pointer over the docking icon, release the left mouse button. The CommandManager will now be docked on the side of the window selected.

**Hide Text in the CommandManager**

When you begin to become familiar with the graphical icons of the tool buttons, you will no longer need the assistance of the text shown in the CommandManager. Hiding the text on the CommandManager will give you more space in your SolidWorks window for working in the graphics area. To hide the text on the CommandManager, do the following:

1. Right-click any spot on the CommandManager.

2. In the menu, deselect the Use Large Buttons With Text option.

3. The CommandManager will change to the smaller, less intrusive version.
Customize the CommandManager

The CommandManager, by default, has most of the toolbars and tools that you would require for your daily usage of SolidWorks. If you select the workflow options that apply to how you intend on using SolidWorks, additional toolbars will be available to you. However, as you begin using SolidWorks and start exploring more tools, you may discover that there are toolbars or tools that you tend to use more often, and therefore you’ll want to add them to the CommandManager.

Add Tabs to the CommandManager

The first and quickest modification you can make to the CommandManager is adding tabs. Say, for instance, you find yourself using more surfacing tools, and you think it would be great to have these tools available in the CommandManager. Here is what you do:

1. Right-click any of the tabs in the CommandManager, and you will see all the currently available tabs that can be added, as shown in Figure 1.22. The items shown that have a check mark are currently in the CommandManager, and you can add the items without a check mark.

2. To add an item to the CommandManager, click an item in the list that does not have a check mark. The item will now have a check mark and be added to the CommandManager.

3. To remove an item from the CommandManager, click an item with a check mark. The check mark will disappear, and the tab will be removed from the CommandManager.

FIGURE 1.22 Adding tabs to the CommandManager
Add Existing Toolbars to the CommandManager

There may be instances where you want to add a tab that is not listed in the right-click menu. No worries, you can add any toolbar that is available in SolidWorks to the CommandManager. Here’s how:

1. Right-click any of the tabs on the CommandManager.
2. Select Customize CommandManager from the menu.
3. To the right of the tabs displayed in the CommandManager, click the New Tab button.
4. Select an available toolbar listed in the menu. The new tab will be added to the CommandManager, as shown in Figure 1.23 (Quick Snaps).

**Figure 1.23** A new tab added to the CommandManager

The new tab will be available only in the document type you are currently editing. For instance, if you added a new tab while in a part document, the new tab will not be shown while editing a drawing or assembly.

It is possible to make the new tab available in the other document types while still customizing CommandManager by following these steps:

1. Right-click the newly created tab.
2. Select either Copy Tab To Drawings or Copy Tab To Assemblies.

**NOTE** If you are adding a new tab to a drawing or an assembly, the option to copy the newly created tab to parts will also be available.

3. Once you are finished making modifications to the CommandManager, click OK in the Customize window, shown in Figure 1.24.

![Customize window](image)

**FIGURE 1.24** Customize window

---

**Create a Custom Tab**

One of our favorite features of the CommandManager is the ability to create a custom tab that can be used to create a group of some of your favorite tools. This can prove to be especially useful if you have a set of common tasks and you want to minimize the number of mouse clicks when selecting tabs. The first thing you will need to do is create a new empty tab on the CommandManager:

1. Enter the customize mode for the CommandManager as discussed in the previous section, and click the New Tab button.
2. On the very top of the menu, select Empty Tab. The New Tab name will be highlighted.

3. Enter the name of the new tab.

4. Add the desired buttons as described in the next section.

5. Once your new tab is finished, click OK in the Customize window.

**NOTE** By default, newly created tabs exist only in the document environment in which they were created. If you want to have the new tab available in all environments, then use the Copy Tab To command discussed earlier.

**Add and Remove Tools in Tabs**

Adding tools to the CommandManager tabs is one of the great advantages of using the CommandManager. SolidWorks, for the most part, did a good job of anticipating which tools will be used most often in various environments, but you may find that there some changes you would like to make. In this example, you will add the Split tool to the Features tab:

1. Enter the customize mode for the CommandManager, and in the Customize window, select the Commands tab.

2. Make sure the tab that will contain the new tool button is active in the CommandManager. If it is not already active, click the Features tab in the CommandManager.
3. On the left side in the Commands tab, the Categories window contains all the tool sets available in SolidWorks. The category name will correspond to the function that the tool set will apply to. For example, you’ll find the Extruded Boss/Base tool in the Features category. Click the Features category, and the available tool buttons will be displayed on the right.

4. Locate the Split tool in the Buttons section. If you are not sure which tool is which, briefly hover your mouse pointer above each tool in the Buttons section until the tooltip is displayed, as shown in Figure 1.25.

![Figure 1.25 Selecting a button to add](image)

5. Drag the Split button directly onto the CommandManager. When the tool can be added, the mouse pointer will change to include a green plus sign.

![Image](image)

6. Release the left mouse button, and the tool will be added to the CommandManager.

Removing tools from the CommandManager is even easier. Here’s how:

1. While still in the customize mode, select the tool in the CommandManager you want to remove with the left mouse button.
2. Drag it off the toolbar. When the mouse pointer changes to include a red X, release the left mouse button, and the tool will be removed.

Use and Customize the Menus

In SolidWorks 2008, the user interface was improved with the addition of a ribbon-style menu bar. The ribbon-style menu helps free up more space on your screen for other functions by automatically hiding when not in use. In the menus, you will be able to find nearly every tool available for each document type in SolidWorks in one of the following six menus: File, Edit, View, Tools, Window, and Help. To view the menus in SolidWorks, do the following:

1. Move your mouse pointer over or click the SolidWorks logo on the left side of the menu bar.

2. To hide the menus once again, move the mouse away from the menu bar.

If you prefer to have the menu bar available at all times, you can “pin” it open by doing the following:

1. Click or mouse over the SolidWorks logo on the left side of the menu bar.

2. When the menu list is visible, click the pushpin icon on the far right of the menu. The menu will remain open at all times.

3. To hide the menu, click the pushpin again.

As with most areas of SolidWorks, the menus are completely customizable to match your needs. Items listed on the main menus can be hidden or shown for each document type. If you hide a menu item in one document type, such as a drawing, it will still be available in another document type as long as it is normally visible in that document type. To customize a menu, follow these steps:

1. Click or mouse over the SolidWorks logo on the left side of the menu bar. Hover over the menu that you intend to customize.

2. Select Customize Menu at the very bottom of the menu. Check boxes appear next to each menu item.
3. Clear the check box next to items to hide them. Select the check box next to an item to show it in the menu, as shown in Figure 1.26.

4. Once you are finished customizing the menu, press Enter or click outside the menu.

Even though SolidWorks gives you the ability to remove menu items, we strongly recommend that you keep all the menu items visible, especially while you are still learning. Once you become more familiar with using SolidWorks, you may decide that it would be best to hide some items, but we personally keep all items visible in the menus.

Use Toolbars

In the past, toolbars played a major role in using SolidWorks; however, with the CommandManager, shortcut bars, and mouse gestures, your reliance on the toolbars will be minimal. Even with the CommandManager, context menus, keyboard shortcuts, and shortcut bars, there will be times that toolbars will be helpful especially when you require a set of tools that you do not use very often. The toolbars in SolidWorks contain most of the tools and add-in products. Each toolbar is named to match a specific task such as Features, Drawing, and Layer.

Hide/Show Toolbars

By default, all the toolbars in SolidWorks are hidden, and even though there are a couple of toolbars that can be activated by keyboard shortcuts, the rest of the toolbars must be activated manually. To show a particular toolbar, you can do one of the following:

► Right-click in the menu bar or on the CommandManager. A toolbar menu appears. Select a toolbar listed in the menu to show it; deselect the check box next to the toolbars you want to hide.
Mouse over or click the SolidWorks logo on the right side of the menu bar. The File, Edit, View, Insert, Tools, Window, and Help menus are now visible. Select Tools ➢ Customize ➢ Toolbars and click in the checkbox next to the names of the toolbars you wish to show; clear the checkbox next to the toolbars you wish to hide.

Rather than going through the long process of hiding visible toolbars, you can quickly and easily close floating toolbars by following these steps:

1. If the toolbar is docked, double-click the toolbar to return it to its last floating position.

2. To close a floating toolbar, click the red X in the top right corner of the toolbar.

Access the Shortcut Bar

We have mentioned a few times already how the shortcut bar nearly eliminates the need for menu items and toolbars. In SolidWorks 2008, the shortcut bar was introduced, and it has quickly become a favorite of many SolidWorks users, including us. Each environment in SolidWorks has its own version of the shortcut bar. Each one has a layout that presents you with the most commonly used tools in the environment you are working in near your current mouse pointer position. Unlike the other toolbars available in SolidWorks, the shortcut bar is not activated by using the procedures described in the previous section. To show the shortcut bar, press S on your keyboard while working in a part, sketch, drawing, or assembly. Make sure that you do not have anything selected when you press S. These are the four versions of the shortcut bar for each environment:

- Part shortcut bar

- Assembly shortcut bar
Customizing a Shortcut Bar

To fully free yourself of using bars, you may find it necessary to customize your shortcut bars to add the tools you will need most often. You can customize each of the four shortcut bars using the same process:

1. In the graphics area, while in one of the four environments that use shortcut bars, press S on your keyboard. The shortcut bar appears.

2. Right-click anywhere inside the shortcut bar, and select Customize (see Figure 1.27).

3. To add a tool to the shortcut bar, ensure that the Commands tab is activated in the Customize window.

4. Select the category that contains the desired tool set. Tool sets appear as icons in the Buttons section.

5. Select a command in the Buttons section of the Customize window with the left mouse button.

6. While still holding the left mouse button, drag the command onto the shortcut bar. When the mouse pointer changes to include a green plus sign, release the left mouse button (see Figure 1.28).
7. Click OK in the Customize window to exit the customize mode.

There is still more you can do to customize the shortcut bar. For one, you can reorder the buttons on the bar. Here’s how:

1. In the graphics area, while in one of the four environments that use shortcut bars, press S on your keyboard.

2. Right-click anywhere inside the shortcut bar, and select Customize.

3. Select a button in the shortcut bar with your left mouse button. While holding the left mouse button, drag the selected button to its desired location. Release the left mouse button.

4. Click OK in the Customize window to exit the customize mode.

As the number of buttons on your shortcut bar grows, you may reach the point where you want to resize the bar. You can also do that while you are in the customize mode:

1. In the graphics area, while in one of the four environments that use shortcut bars, press S on your keyboard.

2. Right-click anywhere inside the shortcut bar, and select Customize.

3. Move your mouse pointer over one of the four edges of the bar. The mouse pointer will change to a dual direction arrow.
4. Press and hold the left mouse button, and drag to resize the toolbar.

5. Click OK in the Customize window to exit the customize mode.

**Access the Context Toolbars**

In addition to the shortcut bar, the *context toolbars* provide you with quick access to the most frequently used commands while in a part, assembly, or sketch. When you select items in the graphics area or in the FeatureManager design tree, a context toolbar will be displayed above the mouse pointer. Select the command in the toolbar to continue (see Figure 1.29).

Although we do not recommend it, you can turn off the context menu in SolidWorks. Here’s how:

1. While in a part, assembly, or drawing, click or hover over the SolidWorks logo on the menu bar. Select Tools ➢ Customize.

2. On the Toolbars tab, there two options for the Context Toolbars in the Context Toolbar Settings section.
3. Deselecting the Show On Selection option hides the Context Toolbar when you select an item with the left mouse button.

4. Deselecting the Show On Shortcut Menu option hides the Context Toolbar when you select an item with the right-mouse button.

Use the Keyboard

In addition to using the CommandManager, Menus, and Toolbars; many SolidWorks users take advantage of the keyboard shortcuts available in SolidWorks. Keyboard shortcuts are great to quickly access your most commonly used tools and can be a real time saver. After learning the most common keyboard shortcuts and creating your own, you will be well on your way to becoming a SolidWorks master.

Use Default Shortcuts

Out of the box, SolidWorks comes with over 40 pre-programmed shortcut keys that in most cases will be more than enough for your daily SolidWorks usage. Shortcut keys can be either single keys or a combination of keys that are pressed simultaneously. Rather than go over every keyboard shortcut that is available, we want to just introduce you to the most used shortcuts that will give you a good start.

The following are keyboard shortcuts that are standard among most Windows based applications and can prove to be very handy in your arsenal. Shortcuts that begin with Ctrl+ are activated by holding down the Ctrl key on your keyboard and pressing the letter or number that follows. The same goes for shortcuts that involve the Shift key or Ctrl+Shift.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
<td>New</td>
<td>Creates a new document</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open</td>
<td>Opens an existing document</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Close</td>
<td>Closes the active document</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save</td>
<td>Saves the current document</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print</td>
<td>Prints the current document</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
<td>Undoes the last action</td>
</tr>
</tbody>
</table>

(Continued)
### Table 1.1 Standard Windows OS Keyboard Shortcuts (Continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
<td>Redoes the last undo or repeats the last action</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
<td>Cuts selection to the system clipboard</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
<td>Copies selection to the system clipboard</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
<td>Copies selection from the system clipboard into the active document</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Browse Open Documents</td>
<td>Switches between open documents in SolidWorks</td>
</tr>
<tr>
<td>Alt+Tab</td>
<td>Switch Applications</td>
<td>Switches between open applications in Windows</td>
</tr>
</tbody>
</table>

In addition to the shortcut keys that are available in all Windows based applications; SolidWorks has a large set of shortcuts that are used. Table 1.2 lists some of the most commonly used keyboard shortcuts available:

### Table 1.2 Commonly Used Keyboard Shortcuts in SolidWorks

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Recent Documents</td>
<td>Allows you to quickly browse the most recent documents opened in SolidWorks</td>
</tr>
<tr>
<td>F</td>
<td>Zoom To Fit</td>
<td>Zooms to fit the view of the model or drawing</td>
</tr>
<tr>
<td>Shift+Z</td>
<td>Zoom In</td>
<td>Zooms in by one step</td>
</tr>
<tr>
<td>Z</td>
<td>Zoom Out</td>
<td>Zooms out by one step</td>
</tr>
<tr>
<td>L</td>
<td>Line</td>
<td>Initiates the line tool for sketching</td>
</tr>
</tbody>
</table>

(Continued)
**Table 1.2** Commonly Used Keyboard Shortcuts in SolidWorks (Continued)

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Magnifying Glass</td>
<td>Displays a magnifying glass for viewing details in the document</td>
</tr>
<tr>
<td>S</td>
<td>Shortcut Bar</td>
<td>Initiates the Shortcut Bar</td>
</tr>
<tr>
<td>Alt+→</td>
<td>Spin Right</td>
<td>Spins the model right in relation to the viewing plane</td>
</tr>
<tr>
<td>Alt+←</td>
<td>Spin Left</td>
<td>Spins the model left in relation to the viewing plane</td>
</tr>
<tr>
<td>Enter</td>
<td>Repeat Last</td>
<td>Repeats the last command used</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Rebuild</td>
<td>Rebuilds new or changed features in the model</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Forced Rebuild</td>
<td>Rebuilds all features in the model</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Redraw</td>
<td>Redraws the screen</td>
</tr>
</tbody>
</table>

**Add and Change Shortcut Keys**

The keyboard shortcuts shown in the last section are a mere fraction of those that are available in SolidWorks out of the box. However, as you begin to use shortcut keys, you may discover that the shortcuts available do not fully suit your needs. Almost all of the commands in SolidWorks can be assigned to a shortcut; the only limit is how many shortcuts you can remember. As you begin to assign shortcuts to the various commands, you may be tempted to go overboard but in my opinion it is best to start out slow by assigning only a few new shortcuts or changing only a couple of default shortcuts. At the time you are creating shortcuts you may think that it would be very helpful to assign a shortcut to every command but in my experience, unless you consciously think about using the shortcuts every time you use SolidWorks, the shortcuts you thought would be a great idea will quickly be forgotten. We personally do not use very
many shortcut keys other the ones listed in Table 1.2 but We have made a few modifications of our own.

In the following example, we will show you how to create a new shortcut. The following is one of the first shortcut assignments we perform on every installation of SolidWorks we use and this is purely a personal preference. If you are familiar with web applications, such as Mozilla Firefox or Microsoft Internet Explorer, you are probably familiar with the F5 key. In many Windows Applications, this is used to refresh the application with any updated information. we have found that many times, we want to press F5 while in SolidWorks to rebuild the model we are currently working on instead of using Ctrl+B or Ctrl+Q. To assign a shortcut to an existing SolidWorks command, do the following:

1. Right-click in the SolidWorks window border or on the CommandManager.

2. Select Customize… from near the bottom of the menu.

3. Select the Keyboard tab in the Customize window.

4. Type the name of the command that you wish to assign a shortcut to in the Search For field. For this example, Rebuild is added to this field. All the commands shown in the window will be filtered out except for the commands that match what is typed in the Search For field. See Figure 1.30.

5. Click on the row that corresponds to the command that you wish to assign a shortcut to. In the description section of the window, an explanation of the command tool will be provided.

6. If the command already has a shortcut assigned to it, the currently assigned shortcut can be removed by pressing Backspace on your keyboard or the new shortcut can be in addition to the existing separated with a comma. If no shortcut is assigned, select the field and move on to the next step.

7. Press the key or key combination that will be the new shortcut for the selected command. If the shortcut is to contain any key other than a letter or number, press the actual key rather than type the name of the key. For example, since we are assigning the key F5 to the rebuild, press the function key F5.
8. If the shortcut being assigned is already being used by another command, SolidWorks will prompt you with a message box asking if you wish to reassign the shortcut to the new command. If you are sure that you wish to change the shortcut, select Yes; otherwise select No.

9. Once the shortcut has been assigned, click OK to close the customize window.

Print Keyboard Shortcuts

With over 40 keyboard shortcuts and any additions you have made, you may find it incredibly difficult to remember all the combinations. Luckily, SolidWorks makes it easy for you to print out a list of shortcut keys that you can reference later. The following will print out the entire list of commands in SolidWorks along with any shortcuts that have been assigned:

1. Right-click in the SolidWorks window border or on the CommandManager.

2. Select Customize… from near the bottom of the menu.

3. Select the Keyboard tab in the Customize window.
4. Click the Print List… button in the upper left area of the customize window.

5. Select your printer and press OK. The entire command list will be sent to your printer.

**Tip** Instead of printing the entire command list, press the Copy List button to copy to the clipboard. You can then paste the list into a text editor or spreadsheet program that you can edit.

### Use Accelerator Keys

*Accelerator keys* provide the user with another way to initiate commands in SolidWorks without the need to use the mouse. Nearly every menu item and dialog box can be accessed with the use of accelerator keys by pressing Alt on your keyboard and the letter that corresponds to the command. Unlike keyboard shortcuts, accelerator keys cannot be customized. However, as you become comfortable with the sequence of keystrokes, you may find your productivity increased. At the end of the day, we are all looking for ways to improve our overall productivity, right? Here is an example of one of our favorite usages of the accelerator keys:

1. Press the Alt key on your keyboard. The menu bar will be displayed at the top of your SolidWorks screen but with a minor difference. One letter in each of the menu headers will be underlined.

2. The underlined letter corresponds with the key you must press to expand the menu list. To expand the File menu, press F on your keyboard, as shown in Figure 1.31.

3. Notice that the menu items also have letters that are underlined. For example, the menu item Properties has the i underlined. If you press i, the Properties window will open, since this is the only menu item that has an i underlined.

4. If there are multiple menu items that share the same letter underlined, such as Reload and Find References, which both have the r underlined,
pressing the letter multiple times will cycle through the menu items. When the desired menu item is highlighted, press Enter to initiate the command.

![Figure 1.31 Using accelerator keys to access menu items](image)

**Figure 1.31** Using accelerator keys to access menu items

---

**Use the Mouse**

Probably one of the first things you learned when you first sat down at a computer was how to move the mouse around and click things. The mouse is one of the most important inventions in the past century because it allows even the most novice user to interact with a PC with little or no training.

Up to this point, you have been using the mouse to primarily select commands, options, and menus, but in SolidWorks the mouse plays a central role in nearly everything you may need to do. Not only is the mouse used to press buttons, select commands, and move toolbars, it’s used to perform the following tasks and more:

- Select entities in the graphics area
- Select commands
- Manipulate views
- Display options for a selection
- Create sketches
- Create extrusions and cuts in models
- Move and rotate components in assemblies
More than likely, you are using a standard two-button mouse with a scroll wheel. Each of the two buttons and the scroll wheel has a variety of functions while working in SolidWorks, and we will be covering each of them in more detail throughout the entire book; however, there are some basic functions you should be familiar with before continuing.

The next few sections are easier to learn if you follow along using the part named ExampleSketch.SLDPRT, which can be downloaded from http://sybex.com/go/SolidWorks-2010-no-experience-required or www.swner.com. Once downloaded, you can open the part by selecting Open from the menu bar; then browse to the folder that contains the part. Click Open in the window, and the part will be displayed in the graphics area.

**NOTE** If you are using a mouse that has more than two buttons, normally the extra buttons can be programmed for particular functions in SolidWorks. Consult the manufacturer’s documentation on how to use the mouse.

**Select with the Mouse**

When not being used to select menu items, buttons, and commands, the left mouse button is often used to select items in the FeatureManager design tree, entities in a sketch, features and faces on a model, models in an assembly, and items in a drawing. In parts, drawings, and assemblies, you need to be in the Select mode in order to be able to select any items.

Many times you’ll find that you need to select multiple objects on-screen in a sketch, model, drawing, or assembly; with the mouse, you can “window” around the multiple entities that you want to select. We have found in the past that there are a large number of people who do not realize that the direction in which you drag the window affects the selection of objects.

**Individual Entities**

To select individual entities, do the following:

1. If you are not in the Select mode, click the Select button in the Standard toolbar.
2. Move the mouse pointer over an item in a sketch, model, assembly, or drawing.

3. Press the left mouse button and release. The item will be selected, as shown in Figure 1.32.

![Figure 1.32 Selecting a sketch entity](image)

4. If you select a second item, the first item will no longer be selected.

5. If you need to select multiple items, press and hold the Ctrl key while selecting the items.
   Clicking a selected item while still holding the Ctrl key will remove the item from the selection set.

**Tip** You can use the Invert Selection tool to select all the other similar items in the document and release the originally selected items.

**Box and Cross Selection**

Two types of selection windows can be used in SolidWorks to select multiple entities: box and cross selection. Both of these selection types will select everything that is completely inside the window, but the cross-selection type will also select everything that crosses the box boundary line. It will help you in your usage of SolidWorks if you become familiar with the two selection types and begin to recognize the visual cues. Open any model, and play around with the two selection types, as follows:
1. Click anywhere in the graphics area with the left mouse button.

2. Hold the left mouse button down while you drag from right to left. This is the cross-selection window (see Figure 1.33). The color inside of the box is green, and the boundary line is dashed. Everything that falls within this box and crosses the dashed line will be selected.

![Figure 1.33 Cross selection using the mouse](image)

3. While still holding the left mouse button, drag the mouse from left to right. This is the box-selection window (see Figure 1.34). You can see how the two selection types differ in their visual cues. The box-selection window appears blue inside the box, and the boundary line is no longer dashed. For an entity to be selected, it must be fully inside the box.

![Figure 1.34 Box selection using the mouse](image)
Use the Right Mouse Button

Up to this point, we have been using the right mouse button to select toolbars and customize the CommandManager, but those are not the only tricks it knows. The right mouse button in most Windows programs is used to access commands quickly and easily, and SolidWorks takes it a step further. The mouse button can be used in two completely different ways to select the commands you will most likely need in any situation. You’ll take a look at both here.

Shortcut Menus

In an earlier section, we mentioned that the context toolbar can be hidden when viewing a shortcut menu. A shortcut menu is different from a shortcut bar; as you may remember, a shortcut bar is activated by pressing S on your keyboard while you are working in a sketch, part, assembly, or drawing. A shortcut menu is activated by the right mouse button when the mouse pointer is over an item in the graphics area or FeatureManager design tree. The shortcut menus give you quick access to some of the most commonly used tools and commands and are broken up into groups of related menu items that are shown with section headings that define the group.

To use a shortcut menu do the following:

1. In a sketch, part, assembly, or drawing, right-click an item in the graphics area or the FeatureManager design tree.

2. To show the entire menu, click the chevron at the bottom of the menu, and it will be expanded to its full length.

3. Select a menu item with the left mouse button (see Figure 1.35).

As with most menus in SolidWorks, it is possible to customize the shortcut menus to hide or show menu items, as follows:

1. In a sketch, part, assembly, or drawing, right-click an item in the graphics area or in the FeatureManager design tree.

2. Select Customize Menu.

3. Click an empty box next to the menu item you want to be shown. The empty box will be updated to include a check mark (see Figure 1.36).
4. To hide a menu item, select the box with the check mark, and it will become an empty box.

5. Once you are finished making adjustments to your shortcut menu, click outside the menu to exit it or press Enter.
To restore all your menus to the system defaults, select Tools ➢ Customize then select Reset To Default in the Menu Customization section of the Options tab.

Mouse Gestures

As if the CommandManager, Shortcut Bars, Context Toolbars, and accelerator keys didn’t make selecting commands quick and easy enough, SolidWorks 2010 introduces another way to design faster. Mouse Gestures are a quick and easy way to select commands without needing to select anything on the keyboard or even without moving the mouse away from what you are doing. At first you may not think about using mouse gestures but after getting used to them you will never want to give them up.

Just like with the Shortcut Bars, Mouse Gestures can be used in all four environments: Parts, Drawings, Assemblies, and Sketches. Mouse Gestures use what are called guides to give you access to eight different commands that are selected by merely moving your mouse. Give it a try and see how easy it is to select a command with Mouse Gestures:

1. While still editing the example sketch from the last sections, press and hold the right mouse button.

2. While still holding the right mouse button, slowly move the mouse in any direction. A wheel, or guide, will be displayed with eight different commands. See Figure 1.37. As you move in one of eight directions, while remaining within the inner circle of the guide, a different command will be selected.

3. To select a command, move the mouse pointer to the highlighted command on the guide. The guide will disappear and the command will become active.
As we said in the very beginning, it may be difficult to remember the layout but as you become accustomed to the button layout you will be able to select a command often without even looking.

**Manipulate Views with the Mouse**

Although the Heads-up View Toolbar, the View Menu, and the Shortcut Menu provide you access to the tools needed to manipulate your views in the graphics area; the scroll wheel on your mouse is often a quicker way to go. The scroll wheel, or middle mouse button, gives you the ability to rotate, pan, and zoom in and out in the graphics area. If you are new to CAD, that last sentence may be a surprise to you. Yes indeed, the scroll wheel that is most often used to quickly scroll through documents is also a button. Give it a try, instead of spinning the wheel, push down directly on the scroll wheel. Now let’s put that button to work for us by learning how to rotate the sketch we have opened.

To rotate the view with the middle mouse button in a part or an assembly:

1. With the mouse pointer in the Graphics Area, press and hold down the wheel.
2. Move the mouse around while still holding the wheel to rotate the view. The mouse pointer will change to the rotate view icon. See Figure 1.38.

![Figure 1.38 Rotating the view using the middle mouse button](image)

You can also rotate the view around a vertex, edge or face in a part or assembly. In this example, we want to rotate the view in relation to the surface of a
model. You will need to download the part named Base_Plate.SLDPRT from the companion site before doing the following steps:

1. Using the Open button in the menu bar, open the model for the base plate.

2. Select a face of the model by pressing and releasing the scroll wheel with the mouse pointer on the face. The mouse pointer will change to show that the rotate view is limited.

3. Press and hold down the wheel.

4. Move the mouse around while still holding the wheel to rotate the view in relation to the face.

To zoom in and out using the scroll wheel in a part, assembly, or drawing, do the following:

1. In a part, assembly, or drawing, spin the wheel forward to zoom out in relation to the position of your mouse pointer.

2. Spin the wheel back to zoom in around your mouse pointer.

3. Move the mouse pointer outside the graphics area. For example, move the mouse pointer to the menu bar.

4. Spin the wheel forward and back to zoom in and out around the center of the graphics area.

In addition to rotating the view and zooming in and out, the scroll wheel can also be used to pan in a part, assembly, or drawing. To pan using the scroll wheel in a part or assembly, do the following:

1. In a part or assembly, press and hold the Ctrl key on your keyboard.

2. Press and hold the scroll wheel.

3. Move your mouse around to pan the view in relation to the viewing plane. The mouse pointer will change to show that you are in pan mode.

**Tip** In a drawing, the Ctrl key does not need to be held while holding the scroll wheel to pan since the view of a drawing cannot be rotated.
Are You Experienced?

Now You Can...

✓ Recognize the elements of the SolidWorks user interface
✓ Use and customize the CommandManager
✓ Use the ribbon-style menu bar
✓ Use and customize toolbars including shortcut bars
✓ Save time by utilizing keyboard shortcuts
✓ Select and manipulate views using the mouse